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about us

In 1978 when Winestate Magazine began it was to set the
benchmark for other industry publications to try and match.
Several decades later, many of those other publications have
been and gone while Winestate has remained and is the
leading independent Wine Magazine in Australia.

This magazine is sold and distributed through newsagents and by
subscription to readers across the globe and through selected
liquor retailers across Australia. Winestate’s sales concentration
is in the larger cities and their high-income suburbs.
Regular Sections.

Going back a over 40 years, Australia had 171 wine and
brandy producers. It was not impossible for a serious taster
to get to know most of them. Today, Australia has more than
2,500 wineries. That’s more than ten times as many. This is
why we at Winestate Publishing employ informative quality
journalists and feature columnists who are knowledgeable in
the goings on of each particular wine region. They give our
publications an array of credible and interesting articles on
upcoming events, personality profiles, new and old wineries,
cellar doors and restaurants and other interesting and
informative topics all in an easy to read format.

• Grapevine / Dining stories & latest reviews from around
Australia & New Zealand.

We have a number of different publications particularly
tailored to suit different market segments:

• Wine & Spirit Insider – Beers, Spirits & Value Wine Buys.

• Wine Tutor
• Wine Investment & Collecting
• What’s its Worth – Auction Section.
• New Releases
• Varietal Style tastings (eg: Shiraz etc)
• Regional tastings (eg: Barossa, Hunter Valley etc.)
• Wine Travel & Tourism

• Winestate Magazine
• The Wine & Spirit Insider
• Winestate On -line
(Our Consumer Website www.winestate.com.au)
Winestate magazine is a consumer wine buying guide aimed
squarely at those looking to buy wine for their home cellar,
their restaurant or for their bottle/liquor store.
Its primary focus is on the Australian reader and has a print
circulation base of 25,000 with an estimated readership
of over 60,000. Increasingly, on-line partnerships with Le
Cordon Bleu, Sydney Wine Academy, William Angliss College
and other teaching alumni have added another 100,000 to
our audience. In future, we are looking to build our China
audience to over, 1 million. Already we have AWSEC Hong
Kong/China’s biggest wine education group involved with over
150,000 alumni.
Its readers are influencers within their peer groups and as
such the magazine impacts on a wide-ranging audience.
Particular areas of influence include wine buyers, wine
investment, wine tourism and the restaurant scene. For the
trade we have secured on-line partnerships with Hospitality
magazine, Australian Hotels Association, Restaurant & Catering
Association and for New Zealand the Restaurant & Catering
Association and the First Glass Wine Show audience, thereby
making Winestate also the most widely circulated magazine in
the liquor trade.

Winestate’s first issue May 1978!
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NUMBER ONE
selling magazine in wine & spirit category

Winestate Magazine is distributed in Australia & New Zealand
through Gordon and Gotch. Australia’s largest independent
magazine distributor. Servicing newsagents and newsstands
using their expertise in distribution.
They have the largest range of magazines in Australia, and
provide this service to over 300 publisher clients through
more than 8000 retail outlets. Over 190 million magazines are
distributed into the Australian marketplace each year, which
has a total retail value of over $600 million.
Gordon and Gotch have an extensive database of
approximately 3400 different magazines across a broad range
of categories. Each month their warehouses around Australia
distribute over 17 million magazines.
Winestate for many years has been the number one selling
magazine in the Wine & Spirit category for Gordon & Gotch
on the news stands.

wine & spirit category
Winestate Magazine Ranked Number 1
in Wine & Spirit Category

food & wine category
Winestate Magazine Ranked Number 6
in Food & Wine Category
Note from Gordon & Gotch
In relation to the Category info, we have
provided both the main category (Food &
Wine) and the sub category (Wine & Spirits).
You will see notated on each category
where Winestate is ranked in the category.
It should also be pointed out, these are of
course Gordon & Gotch titles only and not
reflective of the entire Australian market.
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sponsors events globally

As the world’s biggest buying guide to Australian & New
Zealand Wines our aim is to promote those wines that
achieve the highest results in our tastings.
People are quite often surprised at the amount of work we do
behind the scenes to not only promote ourselves through the
many wines submitted and published in our magazine, but also
to support & sponsor other exhibitions held around the world.
Over the past few years we have supported events such as
Wine Australia and been media partners with the Good Food
& Wine Show and the Adelaide Festival of Arts. Every year we
send one of our team to VinItaly and showcase a selection of
wines from across Australia and New Zealand at the World’s
Largest Wine Show!
Recent sponsorships and media partnerships include the:
Wine & Spirit Asia Singapore
www.foodnhotelasia.com
Hong Kong International Wine & Spirits Fair
www.hktdc.com
Vinexpo Hong Kong
www.vinexpodaily.com
Japan Wine & Gourmet Exhibition
www.wineandgourmetjapan.com
Vinitaly
www.vinitaly.com
Adelaide Festival
www.adelaidefestival.com.au
Top Wine China
www.topwinechina.com
By supporting these exhibitions and other promotions we believe
that it is doing our bit to help keep the interest in Australian
& New Zealand wines to the fore and, of course, it helps the
profile of Winestate to be seen at these prestigious events.
We are delighted that our magazine reaches these important
overseas buyers and that they can use Winestate to help with
their buying decisions including keeping abreast of the new
wines coming onto the market.
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public tasting events

Winestate is a sponsor of the National Wine Centre and
holds a number of VIP tasting events for our readers as well
as being involved in many charity tastings such as the Alfred
Hospital, Breast Cancer Research, Prostate Cancer and more.
At the same time exposing new wines to people who have
an interest in wine. We were very proud to have had nearly
700 different shiraz wines available for tasting at the World’s
Greatest Shiraz Challenge public tasting at the National Wine
Centre in Adelaide each year. This is the biggest tasting of
its kind, with submissions from international producers, with
more entrants from France, New Zealand and South Africa.

At these Winestate Magazine Events we have over 500 wine
buffs in attendance sampling the full range of wines submitted
to our tasting. We do have a number of other events
throughout the year which we have arranged to coincide with
our tastings and have given these events to various charities as
fund raising opportunities. By creating these events it gives us
a further opportunity to promote those wines submitted to
tastings and encourage sampling of brands that many people
have not seen before. Many of the guests on the evenings
busily jot down shopping lists of what to buy when next
purchasing wine.
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added value & promotions for wineries

Point of Sale
Use copies of our Insider for your sales team to set up
promotional displays and prove to retailers that your products
are being promoted.
Third Party Endorsement
Our reputation of calling it how we see it, built up over more
than 4 decades gives your product the street cred and the
independent voice to move recommended products into bars,
restaurants, and liquor stores.
On line Promotions
We can run promotions on-line to add value to your
existing campaign. There are a number of different ways of
integrating our print and online services.
Wine Clubs
We often use surplus wines from our tastings for smaller wine
club tastings again exposing new wines to consumers who may
not have thought of sampling from those varieties or regions.
Advanced Trade Information
We send out our reviews in advance to Liquor retailers so
they can place orders prior to our publications hitting the
newsstands. Our list contains winery contact information so
it is easy for the stores to place orders. This is done usually
6-8 weeks prior to publication.
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winestate publishing readership snapshot

Readership
Winestate
Magazine

Places of
Distribution

Target
Audience

Newsagents
82,000

Subscriptions

Wine Buyers

Wine Club Promotions

Demographic
Snapshot
60% Male Skewed
25 -60 years of age

Inside Winestate

Wine & Spirit
Insider

Winestate
On-line

Independent liquor stores
96,000

Chain Liquor Stores
Restaurants
(Aust, NZ, Singapore,
Hong Kong)

94,935
page views per month

Online only

Wine & Spirit
Buyers

Wine Buyers

57% Male
43% Female
18 – 45 years of age

60% Male Skewed
25 -60 years of age

Tourism offices.

Custom
Publications

Variable on application

E-Newsletter

Can be customised

Point of Sale

Wine Buyers

Variable on application

On-line
Wine Buyers

E-mail

Trade Subscribers
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Variable on application

readership profile

Average price paid for bottle of wine

Age groups

Less than $10

8%

$11 to $20

44%

Under 25

11%

$21 to $50

42%

25 to 39

28%

More than $50

6%

40 to 54

49%

Over 54

12%

Total

100%

Male/Female Splits
Male

60%

Female

40%

Total

100%

Level of interest in wine

Total

100%

How frequently wine consumed
Daily

28%

Several times per week

65%

Once per week

2%

Less than once per week

5%

Total

100%

Beginner

9%

Casual

25%

Serious

66%

Relationship to Wine

Total

100%

Consumer

69%

Trade Buyers

22%

Winery

6%

Other

3%

Total

100%

Winestate readers are influencers within
their peer groups; as such the magazine
impacts on a wide-ranging audience.
Particular areas of influence include wine
buyers, wine investment, wine tourism and
the restaurant scene.

Type of wine most often consumed
Red wine

52%

White Wine

14%

About the same of each

34%

Total

100%
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distribution winestate publishing

Winestate has a national and international circulation
base. Sold at news stands, bookstores, liquor stores and
by subscription, Winestate’s sales concentration is in
the larger cities and their high-income suburbs.
Available at news stands in the UK, US, New Zealand,
Singapore, Hong Kong and more.
Also available in the business lounges of Qantas, Virgin
Australia, Malaysia Airlines, Singapore Airlines, Qatar,
Cathay Pacific and South African Airways lounges.

MarketAsia Singapore

Distributes across news stands in Singapore

Winestate Overseas Distribution

USA

EUR

NZ

EUR

NZ

ASIA

Other

Other

Winestate Distribution by Region

Winestate Distribution by Country

USA

ASIA

NSW/ACT
TAS

Australia
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VIC
WA

SA/NT
Overseas

QLD

tasting submissions & procedures

star rating system

Tasting venues Tastings will be held at Winestate’s Adelaide
office unless otherwise notified. If tastings are to be held
elsewhere, companies will be advised by fax or e-mail of
revised dates and venue details.
Sample Quantities Please supply TWO sample bottles of
each wine. The second bottle will be used should the first
have fault. Prices Please provide RECOMMENDED RETAIL
or cellar door PRICES when submitting, and please indicate
clearly WHICH TASTING the samples are intended for as
well as your CONTACT DETAILS, PHONE, FAX, E-mail and
WEBSITE ADDRESS.
Tax Invoice for entry fee to be included with samples.
Availability All submissions must be bottled final blend. All
must be available to the public when the issue is published.
Regional Tastings Any wine, including fortified, is eligible,
provided that it has at least 85 per cent regional fruit content.
Style Tastings 85 per cent of a wine’s fruit content must be
varietal for it to be tasted as STYLE; wines less than 85 per
cent varietal will be tasted as BLENDS within the class of
their dominant grape. Where blends of varieties are roughly
equal, please show whether the product should be tasted in a
varietal class, or as a generic blend.
New Release Tastings are open to any style, variety or region.
Submission documents are located at www.winestate.com.au

how we compare
Winestate Rating

Comment

Wine show Medal

International
20 Point System

100 Point System

HHHHH

Outstanding

Gold

18.5 - 20

97 - 100

HHHH1/2

Excellent

High Silver

18 - 18.4

95 - 96

HHHH

Very Good

Silver

17 - 17.9

93 - 94

HHH1/2

Good/Very Good

High Bronze

16.5 - 16.9

91 - 92

HHH

Good

Bronze

15.5 - 16.4

89 - 90

Wine judging is an inexact art, not a science - even at the highest levels of proficiency. Accordingly, Winestate uses the star rating
system which reflects a range, rather than a specific point score. Point systems indicate a level of accuracy that simply does not exist.
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tasting & special features 2019
Winestate Magazine
Regional Features

2019

MAY
/June

Tasting
Submission
DEADLINE

Tasting
Submission
DEADLINE

Winestate Magazine
Style Features

Wines of NSW

early February

early January

McLaren Vale, Langhorne Creek
& Fleurieu

early February

early January

Tasting Submission
DEADLINE
New Releases

early February

early January

Western Australia
North Island (Wairarapa, Gisborne, Auckland & Northland)

Yarra Valley & Southern
Victoria

JULY2019
/August

early March
early February

River Regions
Adelaide Hills

* Best of the West - PUBLIC TASTING 24th JANUARY 2019

Organic Wines

early April

Fortified & Sweet White
Wines

early March

Shiraz/Syrah & Blends*

early May

Pinot Noir (AUS)

early April

New Releases

early March
early April

early February

Clare Valley
South Island (Nelson, Canterbury)

North East Victoria

2019

SEPTEMBER
/October

Limestone Coast
Kangaroo Island

early April
early April

early April

New Releases

early June

Pinot Noir (NZ)

Tasmania

Sparkling Wines

Otago (Central Otago & Waitaki Valley/Nth Otago NZ)

*Mainfreight International Worlds Greatest Shiraz/Syrah Challenge - PUBLIC TASTING 24th MAY 2019

early July

Queensland

early July

Clare Valley

early June

Cabernet Sauvignon
& Blends

early July

New Releases

early July

Spirits

early July

Bordeaux Blend Varieties,
Merlot, Cab Franc, Malbec,
Petit Verdot
Dry Riesling & Blends

NOVEMBER2019
/December

Sauvignon Blanc & Blends
Semillon & Blends
Pinot Gris/Grigio
Rosé
Emerging Varietal Awards
Hawkes Bay (NZ) *World Cabernet Challenge - PUBLIC TASTING 30th August 2019

ANNUAL &
Wine of the
Year Awards
January/2020
February
2020 - MARCH
/April

Wine of the Year Awards
Taste-off Trophy Judging
Results*

*Emerging & Alternative Varietals - PUBLIC TASTING 2nd AUGUST 2019

early September

Austria

early August

early September

Brandy

early August

New Releases

early August

early August
*Wine of the Year Awards - PUBLIC TASTING 27th SEPTEMBER 2019

See www.winestate.com.au for updates

All the four- to five-star wines of 2019 in review.
Re-released in July 2020
Barossa Valley,
Eden Valley

early Oct 2019

Central & Western Victoria

early Nov 2019

*Tasting dates and deadlines are subject to change

Chardonnay & Blends

early Oct 2019 New Releases

early Nov 2019

Italian & Spanish Varietals
early Oct 2019

Marlborough (NZ) For New Zealand regional tasting submission deadlines, please contact Kay Morganty - kmorganty@winestate.com.au
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Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212

advertising rates

winestate Magazine
4 Colour Advertisements

Casual

3 x Rate

6 x Rate

9 x Rate

12 x Rate

Double page Spread

$18,000

$14,000

$11,000

$10,000

$8900

Full Page

$10,000

$8000

$6000

$5500

$4900

Half Page

$5900

$5500

$5000

$4700

$2900

Third Page

$3300

$3000

$2700

$2500

$1500

Quarter Page

$2800

$1600

$1400

$1300

$890

1/8 PAGE CLASSIFIED SECTION

$595

$550

$495

$450

$425

Inside Front Cover $22,000 – Inside Back Cover $11,000 – Outside Back Cover $12,000
All rates subject to GST

Casual

3 x Rate

6 x Rate

9 x Rate

12 x Rate

Double page Spread

$24,000

$22,000

$19,000

$17,000

$15,000

Full Page

$13,300

$11,600

$9900

$9000

$8000

Half Page

$7600

$6560

$6600

$5500

$4500

Third Page

$4900

$4700

$4400

$4000

$3700

4 Colour Advertisements

Inside Front Cover $24,000 – Inside Back Cover $12,000 – Outside Back Cover $13,000
All rates subject to GST

Issuance & closing dates
Published last week of the month preceding date of issue.

Inserts: Full run only / prices available on application.

Ad bookings close as published schedule.
Refer Booking & Material deadlines Page.

Frequency discount based on advertiser’s contract year.
Advertisement composition, art, retouching, typesetting and
other services as required will be billed to the advertiser.

No cancellations accepted after closing date.
Agency commission: (conditional on payment being made
within 45 days from receipt of invoice)
Preferred RHP (Right Hand Page) positions incur 10% loading.

Material to be supplied by deadline otherwise publisher
reserves the right to repeat previous advertisement or charge
for space booked.
ONLINE ADVERTISING OPTIONS AVAILABLE WITH
BANNER ADVERTISEMENTS OR LINKS.

Specific position requests upon application.

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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booking & material deadlines

Booking Deadline

Material Deadline

ON SALE

MARCH
/April

12th January

27th January

First week of March

MAY
/June

1st March

8th March

Last week of April

JULY
/August

21st April

2nd May

Last week of June

SEPTEMBER
/October

26th June

4th July

Last week of August

NOVEMBER
/December

22nd August

1st September

Last week of October

15th November

24th November
Special Material sizes
please refer to:
ANNUAL Edition
- artwork sizes or
www.winestate.com.au

First week of January 2020
Re-Released July 2020

ANNUAL &
Wine of the
Year Awards
January/
February

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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digital

Winestate, Australia’s longest running wine magazine, has gone digital with the help of
one of the world’s most pre-eminent digital reader companies, Zinio. www.zinio.com

So why are we so excited about Winestate Digital?

Winestate Digital offers ease of use.

Well, because it’s a fantastic complement to our print version.
Winestate Digital allows for greater interactivity, so whether
you are perusing our Grapevine section and spot a great
restaurant that you would like to check out, or are searching
our contact details page and want to get a direct link to that
winery, it’s all available at the click of a button.

For those with sight impairment or who just want an easier
read, that’s not so hard on the ol’ peepers, Winestate Digital
has a zoom function that makes it very comfortable.
A search function is also available for when you just can’t
remember where you saw that elusive wine or topic of
interest in your current issue.
Winestate subscribers who live overseas no longer have to
wait to get their issue, they’ll receive it the same time that
Winestate hits newsstands here!
This makes giving Winestate Digital as a gift for friends and
loved ones a great idea!

Log on to www.winestate.com.au subscribe now!
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online

winestate on-line
Our online site is used by wine connoisseurs globally to
research information about the best of Australian wines.
Many of the users of our website are current subscribers to
the magazine or use the site for latest news.
Rankings on most search engines puts it generally in the top
10 wine sites.
We have consistently maintained an average of 11 million hits
per annum on the site.
There is a number of exciting user friendly functions on our
site for wine buyers/consumers to use. These include access
to stories as well as sort functions for wine reviews by region,
variety, winery, vintage & price.
We currently have around 12,000 reviews on this site going
back to 2014. Around 10% are viewed for free with out log
in and an additional 25% can be viewed simply by registering
details (still free) To access the remaining reviews users of the
site can subscribe to a paid subscription.
All the reviews that are viewed for FREE are the reviews in the
magazine with either bottle or label shots supplied alongside
the review. In addition these reviews have the winery website
details and contact e-mail below the actual review.

winestate magazine on-line

www.winestate.com.au - RATE CARD
Sponsored Links on Home Page
6 month minimum

$500 per month*

Links

$500 per year*

Premium Links with Logo

$1500 per year*

Direct Marketing via our
Winestate e-newsletter

P.O.A

All rates shown are GST exclsuive
• More than 1 Million page views each year.

*Can be supplied free of charge if print advertising is purchased.
Contact sales@winestate.com.au for details.

• Nearly 11 Million Hits each year.
• Over 94,935 page views per month.
• Over 3000 page views per day.
• Over 18,000 unique user sessions per per month.

Some Key Points:

• Over 216,000 unique user sessions per annum.

• More than 1 Million page views each year.

• Active database of newsletter subscribers.

• We can run banner advertising.

www.winestate.com.au

• Packages for banner ad placement & for links available.
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website banner adverts
material requirements
Winestate, Australia’s longest running wine magazine is online at www.winestate.com.au.
To maximise your impact to your target audience and successfully advertise and market your
business why not place a banner advert on our website. For website advertising inquiries
please contact: sales@winestate.com.au

Examples of
Banner ads

Banner ads can be either created or designed by your
own graphic design or marketing department or with the
Winestate Inhouse designer at a cost (contact production@
winestate.com.au).
Website Banner Ad Specs:
All Banner ads must be within the specs listed below.
• Resolution to be 72 DPI

YOUR
Online Banner
ADVERT HERE

• RGB colour
• Sized at 160 pixels wide x 600 pixels high
• The file can either be a png or jpeg file or it can be an
animated gif file.
• All banner ads must be linked to a company website,
please provide a website for linking.
• Artwork can be emailed directly to production@winestate.
com.au or by using a file sharing service such as Dropbox
or WeTransfer for large files.
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YOUR
Online Banner
ADVERT HERE

Advertising Policies and Content Guidelines
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

All Advertiser Content must be in good taste and must comply with all laws, rules and regulations that apply to the Advertiser, the
Advertiser Content and any location where the advertisements may appear.
The landing page must prominently present the offer being advertised. Example: If the advertisement offers 25% off, then the landing
page must feature the products that are 25% off.
Non-specific calls to action (e.g. “Click here”) are not allowed. Specific calls are acceptable.
Advertising promoting sweepstakes may or may not be allowed, subject Winestate Magazine’s prior written approval.
Advertising “free” goods or services must indicate that terms and conditions apply.
The following advertising and advertising content is prohibited:
Pornography and other “adult” content.
Illicit/illegal drugs and drug paraphernalia.
Gambling or gambling paraphernalia, including online gambling, poker, or bingo.
Tobacco or tobacco related products.
Weapons, including guns, gun parts, kits, mace, nunchucks, halberds, blank powder and ammunition.
Foul, vulgar or obscene language or that features nudity.
Content that is defamatory, libelous, invasive of another’s privacy.
Hate speech - inciting or advocating violence or racial intolerance.
Content that is threatening, abusive, harassing, or advocate against a protected group, whether based on race, color, national origin,
religion, disability, sex, sexual orientation, age or any similar or other category.
Content that promotes any illegal or dangerous activity.
Deceptive, false or misleading content.
Content or technology that infringes, or encourages or enables the infringement of, the intellectual property or personal rights of
others.

Technical Specifications -

General Technical Guidelines

•

Advertisements must not collect any information from or about individual users (whether or not such information is personally
identifiable) without Winestate Magazine’s prior written consent.

•

All advertisements must be in-banner and not expand, either automatically or by mouse roll-over.

•

All advertisements must not include pop-ups and pop-unders, nor may landing pages spawn pop-up or pop-under advertisements to a
user.

•

Winestate Magazine does not allow ads with flashing, a lot of animation, “fake winner” copy or fake functionality such as HTML Selects
or “Search Forms” in HTML or Flash or image format.

•

If an advertisement uses third party tags, please include specific trafficking instructions. A contact at the third party is required and must
be provided to Winestate Magazine prior to the campaign.

•

All impression delivery and billing will be based on Winestate Magazine reporting numbers unless otherwise specified in the applicable
insertion order.

•

If Advertising Content is late or do not meet guidelines noted herein, Winestate Magazine reserves the right to extend the campaign
by the number of days the Advertising Content was late in order to reach the contracted impression goals. However, Winestate
Magazine will work with the applicable advertiser or agency to deliver all impressions within the contracted flight dates pending
placement and available inventory.

•

Advertisements may not use Winestate Magazine or Winestate logos or trademarks or mention or refer to Winestate, its site or its
brand in any manner without Winestate Magazine’s prior written consent.

•

Ads must incorporate advertiser’s trademark. The messaging should not mislead the user.

•

Advertisements must not interfere with navigation on Winestate Magazine website, obscure other content or advertisements, access
or alter computer settings or preferences or otherwise unduly or inappropriately interfere with the user’s experience of or Winestate
Magazine’s operation of Winestate Magazine websites.

•

Advertisements must not trigger downloads of software to a user’s computer without first providing the user with clear and
conspicuous disclosures regarding the installation, operation and removal of the software, and providing the user with an opportunity
to decline to install the software after such disclosures are made

•

The display URL must be the actual destination URL (i.e., the website that the advertisement’s link resolves to, not a redirect) of the
advertisement so that it informs the user of the destination website of the advertisement.

•

The destination URL of an advertisement must work properly and resolve to a working website. It cannot connect to an email address
or file, and must not be under construction.
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STICKERS ORDER FORM
STICKERS PRICE per 1000 @ $75.00 (incl GST if applicable)
Price negotiable for large orders, contact sales@winestate.com.au

T

I
M

A

G A Z

of the Y
E

R

WI

R

E

T
O

P

Recommended by Winestate

4 STARS

Qty_______________

Qty_______________

Best Value Buys $20 & Under

E

ST

IN CL

A

S

Best in Class

Qty_______________

Qty_______________

I

AR

E
N

Qty_______________

N

E

W

E

BEST
VALUE
BUYS

Qty_______________

B

S TA

4 ½ STARS

S

NE

5 STARS

H Y

N
W I

N

Wine of the Year
Trophy Winner
Qty_______________
SUB - TOTAL

$

STICKER ARTWORK IS ACTUAL SIZE

Postage

$

Prices are in Australian Dollars (please contact us for postage prices as they will vary).
See contact details section below.

TOTAL

$

DELIVERY DETAILS
Company Name
Contact Name
Postal Address for stickers
Postcode
Postal Address for invoice
Postcode

CONTACT DETAILS
Please send Australian order form to: F: +61 8 8357 9212 | E: administration@winestate.com.au
Please send NZ order form (GST free) to:

F: +64 09 479 1253 | E: winestate@xtra.co.nz
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editorial calendar
2019
Winestate Magazine
Regional Features

Winestate Magazine
Style Features

COPY DATE DUE
New Releases

Wines of NSW

4th March
2019

McLaren Vale, Langhorne Creek
& Fleurieu

MAY
/June

2019

Western Australia
North Island (Wairarapa, Gisborne, Auckland & Northland)
Yarra Valley & Southern Victoria
River Regions
Adelaide Hills

JULY
/August

Clare Valley

Cabernet Sauvignon
& Blends

New Releases

Bordeaux Blend Varieties,
Merlot, Cab Franc, Malbec,
Petit Verdot

15th April
2019

Organic Wines

2019

Fortified & Sweet White
Wines
South Island (Nelson, Canterbury)

SEPTEMBER
/October

2019

North East Victoria

Shiraz/Syrah & Blends

Limestone Coast

Pinot Noir (AUS)

Kangaroo Island

Pinot Noir (NZ)

Tasmania

Sparkling Wines

New Releases

17th June
2019

Otago (Central Otago and Waitaki Valley, in North Otago)

Queensland

NOVEMBER
/December

Dry Riesling & Blends

New Releases

Sauvignon Blanc & Blends

Spirits

Semillon & Blends

16th August
2019

Pinot Gris/Grigio
Rosé

2019

Emerging Varietal Awards
(EVA)
Hawkes Bay (NZ)

ANNUAL &
Wine of the
Year Awards
January/
February 2020
MARCH
/April

2020

Wine of the Year Awards
Taste-off Trophy Judging Results

Austria

New Releases

All the four- to five-star wines
of the year in review.
Re-released in July 2020.

See www.winestate.com.au for updates

Barossa Valley, Eden Valley

Chardonnay & Blends

Central & Western Victoria

Italian & Spanish Varietals

1st October
2019

*Tasting dates and deadlines are subject to change

New Releases

6th January
2020

Marlborough (NZ)

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
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material requirements
These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print result.
If you have any further questions please do not hesitate to call your advertising consultant.
artwork sizes

Double page:

Trim size

with 5mm bleed

420mm wide x 297mm deep

430mm wide x 307mm deep

FOLD

gutter

Insure type is 15mm from the gutter. Keep all important information 10mm from the top and bottom of your page.

Full page:

210mm wide x 297mm deep

220mm wide x 307mm deep

Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page.
Keep all important information 10mm from the top and bottom of the page.

Half page vertical:

90mm wide x 270 mm deep

N/A

Half page horizontal:

178mm wide x 135mm deep

N/A

Third page vertical:

59mm wide x 270mm deep

N/A

Third page horizontal:

178mm wide x 90mm deep

N/A

Quarter page square:

90mm wide x 135mm deep

Quarter page horizontal:

178mm wide x 68mm deep

1/6 page:

55mm wide x 135mm deep

N/A

1/8 page CLASSIFIED:

87mm wide x 65mm deep

N/A

N/A

cover specifications
Trim size

with 5mm bleed

210mm wide
x 297mm deep

220mm wide
x 307mm deep

Allow 50mm from the top
to allow for the masthead

Insure type is 15mm from the gutter. Keep all important information 50mm
from the top of the page and 10mm from the bottom of the page.

supplying images to WINESTATE
When sending images please DO NOT downsize the file
when e-mailing.
Artwork can be emailed directly to production@winestate.
com.au or by using a file sharing service such as Dropbox or
WeTransfer for large files.
4 RGB JPGs, EPS and Tiff’s will be accepted.
7 DO NOT supply images in Word files or Power-Point.
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5mm bleed

gutter

material requirements
ANNUAL EDITION ONLY

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print
result. If you have any further questions please do not hesitate to call your advertising consultant.
artwork sizes - ANNUAL Edition

Double page:

Trim size

with 5mm bleed

488mm wide x 305mm deep

498mm wide x 315mm deep

FOLD

gutter

Insure type is 15mm from the gutter. Keep all important information 10mm from the top and bottom of your page.

Full page:

244mm wide x 305mm deep

254mm wide x 315mm deep

Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page.
Keep all important information 10mm from the top and bottom of the page.

Half page vertical:

102mm wide x 274 mm deep

N/A

Half page horizontal:

208mm wide x 137mm deep

N/A

Third page vertical:

67mm wide x 274mm deep

N/A

Third page horizontal:

208mm wide x 91mm deep

N/A

Quarter page:

102mm wide x 137mm deep

Quarter page horizontal:

208mm wide x 68mm deep

1/6 page:

68mm wide x 135mm deep

N/A

N/A
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gutter

material requirements
supplying advertisements to WINESTATE
1

File Formats

We prefer files supplied as print ready PDF’s. We also accept hi-resolution tiffs and eps files.
Native files must be provided with links and fonts.
If size permits you can e-mail advertisement to: production@winestate.com.au
2

Images

Each image you use should have the following attributes:
1. CMYK color mode
2. 300dpi (dots per inch)
Once the image has been converted to 300dpi and is the size you need it in the advertisement,
in Adobe Photoshop please view it at Actual Pixels (100%) (under View in main menubar).
At any percentage other than 100%, you’re probably not seeing a fully accurate view of your image.
3

Flatten artwork and embedded fonts

All artwork should be flattened. Layers in Photoshop should be flattened and ALL transparencies
in InDesign flattened. All fonts must be embedded.
4

Gutter and trim

Make sure type is 15mm from the gutter, remember your advertisement could
be on a left or right hand page.
Keep all important information 10mm from the top and bottom of your page.
5

Blacks

All black type must be 100% black. For example C=0% , M=0%, Y=0%, K=100%
(4 colour black will not be accepted)
Solid blacks should be a rich black. For example C=20% , M=0%, Y=0%, K=100%
6

PAGE GUTTER

Hard Copies

Please provide a hard copy colour proof when supplying artwork.
7

Always check your artwork in Adobe Preflight before sending to WINESTATE
See following page for more information.

8 Material to be supplied by deadline otherwise publisher reserves the right to repeat previous
advertisement or charge for space booked.
SPECIFICATIONS - covers

SPINE

SPINE

BACK COVER
TRIM: Width: 210mm
Height: 297mm
BLEED: Width: 220mm
Height: 307mm

5mm bleed

INSIDE FRONT

INSIDE BACK

TRIM: Width: 210mm
Height: 297mm

TRIM: Width: 210mm
Height: 297mm

BLEED: Width: 220mm
Height: 307mm

BLEED: Width: 220mm
Height: 307mm

*NOTE: 15mm gutter on
right hand side. Please keep
important information away
from this area as it may get
lost in the fold.

*NOTE: 15mm gutter on
left hand side. Please keep
important information away
from this area as it may get
lost in the fold.

5mm bleed
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GUTTER*

material requirements
Checking artwork in

Acrobat 7.0 Professional Preflight
This is a MUST before submitting supplied artwork.
1 Open your PDF in Adobe Acrobat
(version 7 shown in example).

4 Click down on the information icon.
This will list all the images in pixels per inch and the
colour mode for all images. Please make sure all
images are 300dpi (ppi) and CMYK.

2 Advanced (in main menubar) > Preflight
b) Make sure Overprint Preview is ticked

3 Click on “List all Images” > Execute

5 Other things to check:
List non-embedded fonts > Execute
List transparent objects > Execute
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material requirements
3 Compression

Creating a PDF from

Colour Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)
Image Quality > Maximum

InDesignCS4
It is important to start the export process with a clean file.
Please make sure the document has been carefully proof
read, all colours are correct, all fonts available and images
are linked properly.
This can be checked in InDesignCS4: File>Package

Greyscale Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)
Image Quality > Maximum
Monchrome Images > select ‘Bicubic Downsampling to’
from the drop down menu > 1200 Pixels per inch
for images above > 1800 pixels per inch
Compression > CCITT Group 4

1 File menu > export
2 Saving your Adobe PDF.

Select > Compress Text and Line Art.
Select > Crop Image Data to Frames.

Select the location you would like to save your PDF,
create a file name and > save.

2 General

Select ‘WINESTATE’ from the Adobe PDF Preset drop down menu.
If this is the first time creating a PDF for Winestate, follow all the steps
first and click on ‘Save Preset’ before you click Export.

Select PDF/X-4:2008 from the Standard drop down menu.
Select Acrobat 5 (PDF 1.4) from the Compatibility drop down menu.

4 Marks and Bleeds

Click ‘All Printer’s Marks’ will select all marks for the PDF.
Click ‘Use Document Bleed Settings’ should be set at 5mm
around the entire document. FILE > Document Setup > Bleed.
*Only add bleed if you are sending a full page, double page,
or cover advertisements.
If you are sending a 1/6, quarter page, half or third page horizontal
or a half or third page vertical you do not require bleed.
Set Offset to 4mm.
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material requirements
Creating a PDF from

InDesignCS4

cont.

5 Output

7 Security

Colour Conversion should be set to No Colour Conversion.
Inks – The only inks showing should be Process Cyan,
Magenta, Yellow, Black. If you have other colours showing,
you need to go to the Ink Manager button, and check on
the All Spot to Process box.

Does not need to be created.

8 Summary

Make sure nothing issues with creating your PDF under the
Options list.

6 Advanced

Job Definition Format should be un-ticked.

A.

B.

9 Save and export PDF
A. If you regularly send artwork to WINESTATE Save Preset.
Next time you can skip all the above steps.
B. Export your PDF after you have gone through all the tabs.

10
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Check PDF in Acrobat Preflight > See relevant page

Winestate 2019
South Australian Wine Tastings & Tourism Features

September/October 2019 Issue – Kangaroo Island
Limestone Coast
May June 2019 Issue – Fleurieu Peninsula
		

McLaren Vale
July/August 2019 Issue – Adelaide Hills
Clare Valley
Riverland

Annual (January 2020) Issue – Best Wines of the Year
		

South Australian Summary Feature
March/April 2020 Issue – Barossa & Eden Valley

Total SATC Commitment – 2019 - 2020 Financial Year - $49,500 (nine
double page spreads).
Note: Greater page commitment at special rates can be discussed.
The package also includes bonus benefits;
Availability of Winestate on-line issue to all SATC audience, free of
charge – July 2019 – June 2020. (We will provide you with a link that
you can send to your members, we do not require your listing thereby
protecting your members privacy.)
100 Hard Copies of each issue – value $1,200 per edition.
One Wine of the Year Awards Special tasting For SATC – 100 wines –
value $3,000
Gift South Australian premium wines as judged by Winestate for SATC
visitors from overseas (can be short notice) – value $5,000
SATC web site banner on Winestate web site homepage for twelve
months - $1,500
Special EDM blast of chosen content to minimum 4,400 wine companies
on Winestate list.
SATC promotional stand at Winestate major events in Adelaide,
Sydney, Melbourne & Brisbane – Value $10,000.

